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Blogger.com User Guide 
 

This guide will help lead you through the process of creating a blog on Blogger.com.  Keep an 

eye out for “red arrows” (     ) that appear in the graphics. These arrows point to items of 

interest, buttons you need to click and/or fields you need to fill in.  Blogger.com makes creating 

a blog easy and fun. 

 

This guide explains only the basic features of Blogger.com.  You can take a quick tour or watch 

some video tutorials located in the Learn more section of their website (see third arrow). 
 

To get started, first you will need to go to the Blogger.com website.  Open an Internet browser 

such as Firefox or Internet Explorer and then type in the following URL: 

https://www.blogger.com.  The website should look similar to the graphic below.  
 

When ready, click on the Get started button to begin (see first arrow below).   

 

If you already have a Google Account, then enter your email and password in the Sign in 

section on the right side of the webpage (see second arrow). 
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Create a Google Account 

 

After clicking on the Get started button, you will be taken to the Create a Google Account 

page.  Blogger.com is a website that allows you to create and store your blogs for free.  

However, they do make you register for their services so they can provide hosting space for 

your blogs.  If you already have a Gmail account, click on sign in first (see first arrow) link so 

you can begin your blogging experience. 

 

If you do not have a Google Account you must first create one at www.google.com.  Then fill 

out the form below and click on the Continue button (see second arrow).  There are many 

benefits to having a Google Account even if you never use your Gmail.  You will have direct 

access to Google Docs (free online programs similar to Word, Excel and PowerPoint) and many 

other programs and services.  You can also use this extra email account when you don’t want to 

give out your regular email. 
 

 

http://www.google.com/
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Name Your Blog 

 

You will now be at the Name your blog section.  This is probably the hardest step, because you 

have to create a Blog title for your blog and also a Blog address (URL) (see first two arrows 

below). The only reason it’s hard is because you have to have a unique URL for your blog.  The 

good news is that Blogger.com checks to make sure the URL you selected is not being used by 

someone else.  To make sure your URL is not being used you can click on the Check 

Availability link located just below the Blog address text box (see third arrow). 

 

After selecting your blog title and blog address, you have to fill in the Word Verification text box 

with the letters located above the text box (see fourth arrow).  This is a security measure that 

helps keep spammers from creating blogs automatically and becoming a nuisance. 

 

Finally, click on the Continue button to finish creating your blog (see fifth arrow). 
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Choose a Starter Template 

 

It is now time to select a template for your blog.  Blogger.com has some predefined templates 

that you can choose from. 

 

Once you see the one you like, click on the template to highlight it (see first arrow). 

 

Finally, click on the Continue button to finish creating your blog (see second arrow). 
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After clicking the Continue button, you will be taken to the page below.  You are now ready to 

begin blogging.  To add posts to your blog, create your personal profile, or to further customize 

how your blog looks, click on the Start Blogging button (see arrow below). 

 

If you did not go to the page below, then you probably had trouble with your Blog address 

(URL).  Just follow the directions provided on the page until you reach the page below. 
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Posting Tab 

 

New Post 

 

You are now at the Posting Tab section of Blogger.com and, more specifically, you are also at 

the New Post subsection.  This is where you create and publish your posts (information).  Posts 

are pieces of information that you share with readers of your blog.  Posts can contain words, 

images, links to other websites and more.  This guide is only going to demonstrate how to 

create a post that contains text. 

 

The first step is to give a name to your post by filling in the Title: text box (see first arrow).  Next 

you can fill out the Text box with your message/content (see second arrow).  You can use the 

text editing tools (bold, italic, text alignments, bullets, etc.) located in the top portion of the 

message box to format your post and give it some style. 

 

Finally, click on the Publish Post button at the bottom to publish your post (see third arrow). 
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Edit Post 
 

To edit an existing post, click on the Edit Posts subsection of the Posting tab (see first arrow).  

A listing of your posts will be displayed.  In the example below, there is only one post listed and 

titled “Welcome” (see second arrow).  You may “view” the post by clicking on name of the post.  

 

In order to “edit” the post, you need to click on the Edit link that precedes the name of the post 

(see second arrow).   

 

You can delete a post by clicking on the Delete link on the right side of the page that 

corresponds with that post (see third arrow). 
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You are now in the Edit Post section of Blogger.com.  You can use the text editing tools to 

change text, make additions or remove text from your post.  You can also edit the “Title” of the 

post if needed.  When you are done making changes to the post, click on the Publish Post 

button to save the changes and publish the post to your blog. 
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The page below is displayed after your post is published successfully.  You can view your entire 

blog by clicking on the View Blog link (see first arrow). 

 

To view your blog post that your just published, click on the View Post link (see second arrow). 

 

To edit the post click on the Edit post link located at the bottom of the page (see third arrow). 

 

To create a new post, click on the Create a new post (see third arrow). 
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Settings Tab 

 

Basics 
 

The Settings tab has nine different subsections (see first arrow).  This guide will only discuss 

the first three subsections.  When you first click on the Setting tab, you are taken to the Basic 

subsection.  The Basic subsection allows you to change the title of your blog (see second 

arrow) and its description (see third arrow). 

 

The Basic subsection also allows you to add your blog to the blogspot.com listing.  Select Yes 

from the Add your blog to our listing? dropdown list (see fourth arrow) if you want your blog 

viewable to everyone or No if you want to keep it private.  Private means that only people you 

share your blog address (URL) with can view your blog. 

 

Similarly, if you would like your blog to be found by search engines (Yahoo, Google, etc.), then 

select Yes from the Let search engines find your blog? dropdown list (see fifth arrow).  Select 

No if you don’t want search engines to find and list your blog to everyone. 
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Publishing 
 

The Publishing subsection allows you to change your blog’s web address.  Blogger.com 

works in conjunction with BlogSpot.com.  Blogger.com is the website where you create and 

edit your blogs.  BlogSpot.com is where your blogs are hosted and accessed from. 

 

In order to change your blog’s web address (URL), fill in the BlogSpot Address text field with 

your new address (see first arrow).  The URL you type in is subject to availability, so you might 

have to try a few different URLs before you find one that is available.  If your address is already 

being used, Blogger.com will provide you with some other URLs that are not being used.   

 

After typing in your BlogSpot Address, you have to fill in the Word Verification text box with the 

letters located above the text box (see second arrow).  This is a security measure that helps 

keep spammers from creating blogs automatically and becoming a nuisance. 
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Formatting 
 

The Formatting subsection has quite a few settings to help format your blog.  This guide will 

only discuss three of the many options listed below in the graphic. 

 

The Show item allows you to change the number of posts listed on the main page by changing 

the number in the Show number field (see first arrow).  The dropdown list next to the number 

field allows you to select Posts or Days from the dropdown list. 

 

To change the way dates are displayed in your blog, select a date format from the Date Header 

Format dropdown list for your blog (see second arrow). 

 

Select your time zone from the Time Zone dropdown list (see third arrow). 
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Design Tab 

 

Page Elements 
 

The Design tab has three different subsections (see first arrow), Page Elements, Edit HTML 

and Template Designer. 

 

When you first click on the Layout tab, you are taken to the Page Elements subsection.  The 

Page Elements subsection allows you to add and move page elements around in your blog 

(see third arrow).  To add a gadget (function) to your blog, click on the Add a Gadget link and 

choose a gadget from the list of gadgets that appears (see third arrow).   

 

To move gadgets or page elements around in your blog, simply click on a gadget and drag and 

drop it where you want it to reside.  In the example below, you could click on the About Me 

element and drag it up above the Followers element and let go (see fourth arrow).  

 

Be sure and click on the Save button to save your page element changes (see second arrow). 
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Edit HTML 

 

The Edit HTML section is only for those who are comfortable editing web pages using hypertext 

markup language (html).  If you are not a familiar with html, then skip this section.  

 

In order to make changes to your blog beyond what the template provides, click on the Edit 

HTML subsection from the Layout tab (see first arrow).  Next make the changes to your html 

code and click on the Preview button to view your changes (see second arrow).  If you don’t like 

the changes you made, click on the Clear Edits button (located next to the Preview button) to 

remove the changes you made. 

 

Finally, if you like the changes, click on the Save Template button to save your blog with the 

changes you made using html (see third arrow). 
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Template Designer 

 

When you first created your blog, you had to pick a template for your blog.  The Template 

Designer subsection allows you to change your blog’s template.  In order to change your blog’s 

template, click on the Template Designer subsection from the Layout tab. 

 

Next, use the gray arrow on the right to view the all the templates available to you (see second 

arrow).  Click on the template to highlight it and your blog will be displayed with the new 

template live on the webpage.  Notice that each template has “sub-templates” displayed under 

them that make background and color changes (see third arrow).  Be sure and click through the 

sub-templates to see all the possibilities for each template. 

 

Finally, click on the Apply to Blog button (located at the top right of the page) to save your blog 

with the new template style, colors and features (see first arrow) or click on Back to Blogger 

link (located next to the Apply to Blog link) to leave without making any changes. 
 

 


